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AC mode image of Fibrin on methyl terminated 
SAM in air 

 
The purpose of this ‘Manualette’ is to offer new users some documentation on how to procedurally 
operate an Asylum Research MFP-3D™ AFM. It’s like a manual, but more brief and to the point 
regarding procedures. Its inception was to alleviate time spent training lab members, and has 
evolved into a document to help new or sporadic users how to navigate the software, and be more 
efficient at operating their AFM. Essentially, I’d like your operational learning curve to be reduced 
so you can be more efficient in the lab. 
 
 It is assumed that the MFP-3D™ manual has been perused, such that I am not responsible for 
omitting such common sense precautions as: don’t stare into the SLD, don’t drop or abuse the 
equipment, or don’t leave the controller teetering on the edge of the bath tub. It is an expensive, 
high precision instrument, and should be treated with great care. 
 
This Manualette:  
-is broken down into sections that are in a logical progression of obtaining AFM images, or simple 
force spectroscopy experiments, and the subsequent data analysis.  
- only discusses operation of the MFP-3D™ itself, and does not include any optical microscopy 
techniques, if your MFP happens to be sitting on an IO. 
- is in continual development, so more insightful, updated versions occur every few months. The 
next version will have descriptive procedural electrical characterization and lithography techniques 
in it, as well as a section describing what most of the features in every software panel do (in a 
procedural sense). Regarding the latter, for now just look in the help menus- they are there for a 
reason. 
 
If you are not familiar with Igor, you should read through the 
getting started manual that comes with the software. 
 
I also suggest when updating new software from Asylum, read 
the ‘what’s new’ read me files; they are often very descriptive. 
 

The ‘MFP3D Help Files’ under the Igor Help menu are also 
very useful, especially for image analysis and display.  
 
Some features of this manualette- 
Orange text represent topic sections 
-Any where there is a gray bold text in single quotes, means it’s 
an execution button in the software; example ‘Simple Engage’, looks like this button: 
Bold text represents new software features or tabs 
▪ denotes a new concept or comment 

 checkmarks denote a procedure, typically these are in a series of instructions and are included 
to help guide the eye through specific operations 

 
Blue text represents a Note or empirical trick- something I have picked up along the way, and 
include so it may not take you as long to figure it out as it did me; it is also accompanied by a 
little note icon in the margin. 
 
 
I tried to incorporate as many software and hardware images to help describe from a more visual 
point of view. There are no equations in this document. 

 



Ryan’s MFP-3D™ Operation Manualette, Version IX 9/2006 3

I. LOADING THE CANTILEVER 
 

▪ Load tip holder into loading apparatus (Figure 1A), which offers stability when loading tips. The 
tip holder has a kinematically machined ball bearing port that snaps into place using the lever on 
the apparatus and head port. The tip holder apparatus works great for rinsing the tip holder after 
imaging. 

 
▪ Slide cantilever chip under tongue of tip clamp. Position cantilevers so that they are (more or 
less) centered in the clear trapezoidal shaped Kel-F window (Figure 1B). The Kel-F tip holder was 
designed to be resilient to scratching from tweezers, so don’t be paranoid. For best results, DO 
NOT push tip chip substrate all the way back in the pocket: it can cause the chip to lift off the floor 
of pocket which then compromises the deflection signal (i.e, no signal).  
 
▪ Tighten the screw in the center of the stainless steel tongue assembly (finger tight). This 
generally allows for suitable chip coupling to the tip holder. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

▪ Put tip holder into the MFP-3D head I find it easiest to put the ball bearing on release lever side 
of the kinematic system first; then ease the holder in the back. Make sure the tip holder is parallel 
to the top of the head; other wise it is not properly seated.  

 
 

▪ If you haven’t already, open the MFP-3D software; the launch icon is on 
desktop.  
 
 
▪ Program is loaded when Igor says its ready (lower left hand side of window). When Igor is busy, 
it doesn’t want to be interrupted; while this is occurring, typically the Abort button in the lower left 
of the MFP-3D software shows this 

 
 
 
 
 
 
 
 

 

Figure 1. A) loading the tip holder into the Cantilever holder stand. B) use tweezers to position tip in middle of polished 
quartz window. C) Loading tip holder into head. 
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Figure 3: laser alignment pattern 

II. LASER ALIGNMENT:  
 

There are two ways to initially (rough) align the ‘laser’ on the tip: 1) use IR card, 2) use overhead 
CCD camera (top down view optics ccd camera only). The laser is actually a super luminescent 
diode, but it’s easier to call it a laser. 
 
▪ The top of the MFP-3D head is conveniently labeled (Figure 2). The thumbwheel on the right 
moves the laser along the length of the cantilever, while the one on the back of the head moves 
it across the cantilever. The head has arrows indicating which way the laser will go as they are 
moved CCW.  

 
Turn on the laser (diode) by turning the key on the front of the controller 90 degrees clockwise. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 

1) Laser Alignment via IR card: (for use with heads without 
camera, or for the MFP purists): This is done on a stand that is 
kinematically machined for the legs, or a table top- just 
somewhere your sample isn’t.  

Place the card under the tip holder. Figure 3 (right) attempts to 
depict this procession. If the laser spot isn’t being blocked by 
anything, you can see it on the IR card. If you can’t see it, move 
the laser along the length of the cantilever until you do.  
Then follow this procedure: 

Move the beam back onto the support chip (no spot visible) (1);  

Figure 2: MFP-3D head and its thumbwheel locations (top down view model shown). 

x-, y- camera 
translation for 
top view optics 

Camera focus Deflection (PD) 
adjustment 

Laser 
adjustments 

Engagement 
thumbwheel 
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Move the beam forward a bit until you see it (2); At this point, the laser is just past the edge of 
the chip 

 Next, move the laser perpendicular to the length of the cantilever (3). When you encounter the 
cantilever, you will see the ‘Sum’ voltage signal increase.  

At this point, use both laser alignment thumbwheels to maximize the ‘Sum’ voltage (4). 
Incidentally, the IR card needs to be moved occasionally to find a ‘fresh’ area that will glow. 
▪ Place the head onto stage with sample. Make sure you’ll have enough room such that you don’t 
crash your tip. 

 
-OR- 
 

2) Laser Alignment via top view optics CCD: -Turn CCD camera on (look for 
ccd icon on lower left of MFP-3D software); focus camera on tip using focus 
adjustment wheel on back of AFM head. The two knobs in the back of the head 
are for x- and y- position adjustment of the camera; the large wheel in the 
housing is for focus. CCW focuses down, CW focus up (in the plane of the tip). 
See Figure 2 for location of adjustment knobs on MFP3D head. 

 
I usually follow a pattern remarkably similar to Figure 3 (except you follow the laser spot in the 
camera):  

Move the laser back onto the support chip to locate it in the camera view, and then move it 
towards to the end of the desired cantilever. 

This results in a ‘Sum’ signal on S & D meter.  
Move the laser in x- & y- to maximize the sum.  

 
Adjust Photodector (PD): Use the thumbwheel on the left side of the head (Figure 2) to adjust 
the PD, whose value is seen in the Sum & Deflection meter (Figure 4). This meter window is set 
up rather conveniently: If you have red in the deflection meter, you need to go negative to adjust 
to ca.  zero. The top of the head is labeled to tell you what way to go (positive or negative). When 
aligning the laser, just pay attention to the Sum and Deflection meter voltage values.  

For contact mode imaging, the deflection should be slightly negative (slightly blue); for AC mode, 
it should be zero (no color). 

At any point, clicking the ‘Withdraw’ button will disengage the tip, retracting the piezo to a 
reading of 0.0V (mostly blue on the meter).  
▪ Figure 4 shows the piezo fully extended anticipating set point to be achieved 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

ccd icon 

Figure 4: Sum & Deflection Meter (all values in volts); 
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▪ At this point, you are ready to engage the tip, depending on what imaging mode or application 
you are doing. If you are working in fluid, you may have to wait out an equilibration period. You will 
see significant drift in the deflection value without equilibration (seen in deflection value of the S & 
D meter). 

 
 

CAUTION: When adjusting any of the alignment thumbwheels, if you feel 
resistance turning them, don’t force it. It’s probably at the end of its travel. If 
you over torque it, it becomes very difficult to reverse its direction. 
 

 
 

Regarding the software, the help menus can be helpful for explaining functions in 
the instrument. Anywhere a ‘?’ occurs to the right of a panel/ dialogue, there is a 
link to the help menu describing its function. Quite often the help menu is 
descriptive, yet doesn’t necessarily describe functions in a procedural sense.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

SEBS polymer imaged in air 
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Figure 5: Main tab of Master Panel 

Radio 
Button

Figure 6: Master Channel panel with Channel 
input options. 

III. CONTACT MODE Operation: 
 

▪ From Main tab in Master Panel, select ‘Contact’ mode from the imaging mode pull-down menu   
(Figure 5). 

 
Image channel selection: Before scanning, you must choose what kind of data you want shown 
during imaging (i.e image channels).  

Click on a channel tab in the Master Channel Panel (Figure 6) 
At the ‘Input’ pull down menu to choose what data you want for contact mode imaging (i.e, 

height, deflection, lateral, etc).  
 
▪ If you want lateral data, but don’t change these tabs from the default AC mode imaging windows 
(i.e, Ht, AM & Ph; seen below), you are just going to have some noisy looking image that isn’t 
representative of your surface.  
 
For more on the Master Channel Tab, see Section IV. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
▪ Adjust deflection value to slightly negative for contact mode 
(deflection meter is a little blue, like 0 to –0.20 V). This is done 
to compensate for a ca. zero deflection once tip is engaged. 
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▪ On the Main tab (Figure 5), adjust these parameters (dependent on sample):  
Set point (force): minimum of whatever the deflection value on the S&D meter is (gentle, low 

force) to 1.0 V  (higher force; the larger the value, the larger the applied force); if you need to 
know what kind of force you are applying, you should determine the spring constant (k) using the 
procedure described in Section IV. 

Integral gain (I): 5 to 10,  
Scan rate: 1 Hz.  
Scan angle, resolution (scan points & lines) and image size is up to you.  

 
▪ At this point you are ready to engage for an imaging-only application (i.e, if you are not 
interested in knowing the spring constant of your cantilever).If you want to determine spring 
constant, see section III. 

 
 

Tip Engagement: Click ‘Simple Engage’ in the Sum and Deflection window (Figure 4). You will 
notice the z-piezo voltage maximizing all the way red (150 V), indicating the z- piezo is fully 
extending in anticipation of engagement of feedback servo.  

 
▪ Slowly turn the thumbwheel counter-clockwise (towards the surface) until the deflection value on 
the S&D meter equals your user defined set point, AND you here a chime sound (computer 
speaker volume must be on). You will also notice the z-piezo voltage meter goes from ‘railed’ in 
the red (150 V), to some lesser value. If you have the volume up on the transducer (front of 
controller, headphones plugged in), you can hear a frequency change immediately before 
engagement occurs.  
▪ Carefully adjust the front thumbwheel down to around zero (~ 70 V; no color in z-voltage meter). 
This indicates the piezo is in the middle of its z- range (~ 7.5 µm standard head; ~ 14 µm 
extended head). 
 
At this point the tip is engaged and just sitting on the surface- it does not begin rastering until you 
tell it. You can now being imaging (see next step) or determine spring constant (Section IV). 

 
 
NOTE: If the z-piezo voltage is railed all the way blue (-10 V, upon clicking simple 
engagement), the piezo is fully retracted because it thinks it has crashed. This 
indicates a false engagement and adjustment must be made. Do this by clicking ‘Stop’ 
and adjusting the set point voltage or drive amplitude (if in AC mode-Section VII) to 
allow extension of the piezo. This often occurs when imaging in fluids/ high humidity.  

 
 

To begin scanning, click the ‘Do Scan’ button on the Main Tab. After a brief moment, imaging 
will begin.  
▪ Tune the parameters with set point force, integral gain (I) and scan rate. You can use the arrow 
clickers to adjust parameters, opposed to typing values in.  
 
▪ Alternatively, you can fine-tune the parameters using the ‘Hamster’ wheel on the front of the 
controller. Any parameter with a ‘radio’ button next to it (Figure 5) can be changed during a scan 
when it is activated (looks like black dot in circle) with the ‘Hamster’. The Hamster gives digital 
control with analog feel. The toggle switch to the left of the Hamster allows you to toggle between 
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Figure 7: Flattening options 

radio buttons in the panel. This is a GREAT feature for tuning on the fly, and you don’t need to use 
the mouse. (The Hamster is also functional in the Force panel, described later in the force 
spectroscopy section). 

 
▪ Image quality can be monitored by image resolution and amount of noise in the line traces 
(located below images). 

 
 
▪ Rotating the scan angle results in counter clockwise rotation with positive rotation angle values. 

 
NOTE: Scan angle has to be at 90° for lateral force microscopy (LFM). This may be 
obvious, but the author mentions it because some other commercial scopes scan 
perpendicular to the lever at 0°. 
 

▪ When finished scanning, see shut down procedure below (Section V). 
 

 
 
IV. IMAGE CHANNELS/ SCALING/ FLATTENING: 
 
▪ The z-scales of the images can be auto-scaled by creating a square with the mouse on the 
image, right or left mouse clicking & selecting the ‘fit scale’ option. That will auto scale using the 
pixel values within the square; it will auto scale in that image only. You can also select ‘Fix all 
scales’ and have the auto scale update in all open image channels.  

 
 

▪ Alternatively, you can manually select z- values in the ‘Master 
Channel’ window (Figure 5 or 7) with Data Scale, or hit the ‘Fix’ 
button to auto scale. The Data Offset can be adjusted the same 
way. 
 
▪ ‘Live Flatten’ options can also be selected from pull down menu 
(Figure 7). Similar pull downs exist for ‘Save Planefit’. 
 
 ▪ Trace or Retrace on the image display is chosen in this 
window. Capturing the trace and retrace data usually increase 
your chances when looking for that ‘publication quality’ image. 
 
▪ The Auto  check box (if checked) auto scales the trace/retrace 
lines (below the image) with every slow scan line added. If this 
box is unchecked, it scales to what ever the Data Scale value is. 
For example, if the Data scale value is too low, then trace/ retrace 
will be clipped; this also depends on the Data Offset. 

 
 

NOTE: Due it its linearity, the Z sensor (LVDT) gives much more accurate heights for features 
above ~ 1 um, than does the height which is based on the piezo values. You should this 
channel as often as possible, in addition to the height channel. 
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V. SAVING IMAGES: 
 
▪ TO SAVE / CAPTURE IMAGES, choose a 17 character title (it can’t start with a number) and 
type that into the Base Name slot in the Main Tab of the Master Panel (see Figure 8). 
 
▪ Click the Save Images  checkbox which brings up a dialogue to choose where to save it. Use 
‘Browse’ button to change folders, or type a new folder name. The software is designed to do 
continuous capture, which will increase the ‘Base Suffix’ by one with every image. 
 
▪ The ‘Note’ line allows an unlimited length of text to describe imaging / experimental conditions; 
this can be recalled in ‘Show note’ option under the commands pull down of an display window 
(offline analysis -see Section X) 
 
▪ ‘Save Partial’ is like ‘force capture’; you’ve changed the parameters, yet you still want to save 
the image 
▪ ‘Browse’ lets you look at saved images (also see Section X) 
▪ ‘Save Prev.’ saves the image scan previous (it’s temporarily stored in experiment memory) 
▪ ‘Save Status’ tells you if it’s saving current scan or next. 

 
 
 
 
 
 
 
 

 
 
 
 
 
 

Figure 8: Capture part of Main Tab 

Psuedomonas Aeruginosa imaged in air 
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VI. DETERMINATION of SPRING CONSTANT:  
-some of these procedures have been iterated in Section III.- 

 
The determination of spring constant (k) is a 2-step procedure: 1) determine the slope of contact 
region from a force curve to determine the sensitivity of the lever (in nm/V); 2) perform a thermal 
tune to determine resonant frequency of your cantilever. An algorithm computes the spring 
constant using the equi-partition theorem. 

 
 
▪ Engage in CONTACT MODE on a clean, hard surface (like freshly cleaved mica). 

Select ‘Contact’ from the Imaging Mode pull-down menu on the Main Tab of the Master panel.  
Choose a set point force: low force is slightly larger than the value of the Deflection value (volts) 

in the S&D meter; (I usually choose 0.2 to 0.5 V) 
Integral gain = 5 to 10 (integral gain) is usually sufficient. 
Click the ‘Simple Engage’ button on the S&D meter; Engage tip by turning the thumbwheel until 

you here a bell sound; the z-voltage goes from railed in the red (150 V), to some other lower 
value.  

Slowly adjust this down to around 70 V (no color in z- voltage meter).  
 

NOTE: if you need to engage as gently as possible, it’s best to do a false engagement 
in AC mode first, then increase the set point force until the tip hard engages at the 
minimum possible force; then switch over to Contact mode once engaged. See Section 
VII for this gentle engagement procedure. 

 
 Click on the Force Tab of the Master Panel (Figure 9): This panel is set up so the user can 

define the specific distance the piezo travels during the force-distance cycle (called ‘Force 
distance’ in Force tab).  
▪ The objective in this step is to measure the slope of the contact region (called the ‘inverse optical 
lever sensitivity’; or InvOLS), a parameter necessary for the algorithm to determine the spring 
constant. The white bar on the left side of the window represents the entire 15 µm (or 28 µm) 
range of the z- piezo. The red bar represents the ‘Force distance’- a user-defined approach/retract 
cycle distance that the z- piezo moves during the force-distance curve acquisition. As you change 
the force distance, you can see the size of the red bar’s length change. This can also be activated 
with the Hamster wheel.  
 
For a more detailed description of the Force Tab, see Section IX (Force Spectroscopy) 

 
Initial Parameter adjustment-  

Choose a ‘Force’ distance (0.5 to 1 µm).  
Activate the ‘Trigger’ from the Trigger channel pull-down menu- choose the ‘DeflVolts’ channel, 
Enter a ‘trigger’ point value of 0.2 to 0.4 V. Most other parameters in Figure 9 are not important 

at this point.  
Choose a start distance with the red bar towards the beginning of its travel (top). Activate the 

‘relative’ trigger radio button,  
Click the ‘Single Force’ button. This makes the software choose a proper start distance on its 

own, and you should have a force distance curve that looks similar to the one in Figure 10A.  
▪ The first force curve should have a very long approach (red) curve because the piezo was 
traveling toward the surface waiting to reach a force equal to the trigger point selected.  
 

STEP 1: 
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NOTE: The trigger point value is the amount of deflection the tip undergoes (once the tip is 
in contact with the surface) before the piezo switches direction for retraction.  

 
 

This process can be monitored in real time by listening to the transducer (headphones). 
When the tip makes contact, you can hear it go from a static noise to quiet/ dampened 
(contact), and back to static sounding upon retraction.  

 
 
= 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 10: A) Force distance curve on a hard surface. 
Cursors placed on linear region of contact (repulsive) 
regime. Use Ctrl + I to get cursors. B) ‘Set Sens’ parameter 
to deflection to update InvOLS value. C) resulting curve fit 
(black line) between cursors fit line 

Figure 9: Force Tab of Master Panel 
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▪ So now you have this force curve that looks similar to the one in Figure 10A. It’s time to 
determine the InvOLS (inverse optical lever sensitivity) of the cantilever from the slope of the 
contact (repulsive) region of the force-distance curve. This will complete the first step to determine 
the spring constant of the cantilever… 

 
With the force plot window active, hit Ctrl + I brings up a panel on the bottom that has cursors 

(A:⊗, B:⌧; with there respective x-, y-, dx, dy values).  
Move one of them (by holding down with left mouse button) on to a linear part of the contact 

region of the curve; put the other cursor on another part of the linear region in the same fashion 
(see cursors in Figure 10A).  

Make sure you have both cursors on the same trace, use the keyboard arrow keys to assure 
they both move in the same direction. If they move away (or towards) each other, they are not on 
the same trace.  
 

NOTE: you can deactivate one of the cursors on the curve by going into the lower margin of 
that Igor window and clicking on the open circle/square. When it’s deactivated, it will turn 
black allowing you to finely position the other cursors on the curve. When done, reactivate 
and check that both cursors are on same trace. 

 
▪ You should have a plot that looks similar to the one in Figure 10A. 
 

 
▪ In the Force tab, click on ‘Deflection’ in the ‘Set Sens’ pull-
down menu (Figure 11). The ‘Defl InvOLS’ (deflection  
inverse optical lever sensitivity) value will automatically be 
updated in the force panel, and connects the two cursors 
(⊗,⌧) in the deflection vs. LVDT plot with a thick black line 
(Figure 10 C). It’s a good idea to record this InvOLS in your 
notebook. (Amp InvOLS is Defl InvOLS times Kappa). 
 
▪ Amplitude should be selected if doing force distance curve 
in AC mode 
 
▪ Virtual Deflection calibration is described in Section IX. 
 

 
Disengage tip by clicking the ‘Stop!!!’ button on the bottom of the ‘Main’ tab of the master panel, 

or by clicking the ‘Stop’ button to the right of the deflection meter on the Sum and Deflection 
Meter window, or by clicking the ‘Withdraw’ button in the Force tab. All do the same thing: the 
S&D meter should show a piezo voltage of 0.0 V in its ‘withdrawn’ position. 

 
 
Click on the Thermal tab on the Master Panel (Figure 12).  

Adjust the deflection on the AFM head so it reads zero deflection in the Sum & Deflection meter. 
Click the ‘Do Thermal’ button at bottom of panel. This detects the natural resonant frequency of 

the cantilever by doing an iterative series of frequency sweeps and averaging them. A real-time 
amplitude vs. frequency (power spectrum) plot comes up like the one seen in Figure 13 (see 
Figure 16 for thermal power spectrum in fluid). Let it go through many cycles (the more you 
collect, the more it filters out noise).  

STEP 2: 

Figure 11: selecting sensitivity to 
update InvOLS value 
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How fast the Thermal tune proceeds is dependent on the resolution value: 3 is very good, but 
slow; 7 is pretty efficient but produces a noisier plot.  

 
 Hit ‘Stop Thermal’ to cease sampling when plot looks like it has definition enough to fit a curve 

to it. On the power spectrum plot  (Figure 13A), expand the first large peak (red dash line). Do this 
by holding down the mouse button and creating rectangle around peak, then right or left clicking 
the mouse button; select ‘Expand’ to give a plot similar to Figure 13B. Hit Ctrl + I to get the Igor 
cursors (⊗,⌧ at bottom); place one on the peak of the first resonant peak. Read the value from 
the cursor (X value, which is in Hz) and type this value (in kHz) into ‘Zoom Center’ parameter on 
the thermal tab (Figure 12). If working in fluid, the peaks are much broader (see Figure 14A), and 
their resonant frequencies shift to about 1/3 their ‘in air’ values. The red vertical lines in Figure 
13B correlate to the ‘Zoom Width’ value in the Thermal tab. 

 
 

In Igor, Ctrl + A will get you back to full spectrum in any expanded Igor window / image. 
For example, this would get you from Figure 13B to 13A. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click on the ‘Show Fit ’ checkbox; then  the ‘Fit Guess’ button (this brings up a blue Gaussian 

shaped curve very near to the thermal resonant peak); Click on the ‘Try Fit’ button- a blue curve 
will fit to this resonant peak (Figure 13B). The software automatically calculates the spring 
constant and updates the resonant frequency, seen in Thermal and Main tab. 

Figure 13: Frequency vs. amplitude plot from a thermal 
tune (taken in air). A) full-scale spectrum. B) zoomed 
and fitted (blue line). Figure 12: Thermal Tab 
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NOTE: when using a floppy cantilever IN FLUID, I’ve found that there is a dampening 
effect that causes difficulty computing this peak position (see Figure 14B below). There 
are ways around this: 1) take the frequency spectrum before engaging/ taking force 
curve; perform a try fit once you have the InvOLS value (there will be some greater error 
in k determination with this approach). 2) disengage the tip and manually retract of the 
tip a turn or two of the thumbwheel (20 to 40 µm) before taking the freq. / spectrum. This 
seems to work much better, with a low number of iterations. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
▪ At this point the software has determined the cantilever’s spring constant by the equi-partition 
method. This is very useful when performing force distance curves or needing to know how much 
force the set point is applying to the tip. This value will be store in any saved data parameter file. 
 
▪ Determining spring constant without making contact with surface- Keith Jones (AR applications) 
has a protocol to determine this. Look for it in version X of the manualette. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14: Thermal tunes of contact mode cantilevers IN FLUID. A) typical plot. B) one that has fundamental peak 
dampened (see note below): Program has difficulty fitting to dampened fundamental peak 

A B 
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Figure 16: Cantilever Tune results. Teal line is the Phase. 

Figure 15: Tune tab 

VII. AC MODE Imaging: 
 
From Main tab in the Master Panel, select ‘AC mode’ from the imaging mode pull-down menu 

(Figure 5). 
 

▪ Adjust deflection (PD) to zero (volts) for AC mode (no color in deflection meter). Sometimes I go 
a sliver negative (blue). 

 
Open the Tune tab of the Master Panel (Figure 15). Make sure the “Target Percentage” is  -5.0 

%. The default Auto Tune high and low values are 50 kHz to 400 kHz, respectively. Most drive 
frequencies for AC mode cantilevers fall within this frequency range (in air). Click the ‘Auto Tune’ 
button. You can hear the shaker piezo sweep, and an auto tune plot similar to the one in Figure 16 
comes up. The software automatically picks a drive frequency on the left side of the resonant peak 
at -5% of peak maximum at the (minimum) Drive amplitude needed to make a 1.0 V amplitude in 
the S&D meter. The target amplitude & percentage can also be defined by the user. The drive 
frequency value will automatically be updated in the Tune and Main tab of the Master Panel, and 
the Q of the cantilever is determined.  

 
▪The teal colored curve is the Phase, which is set to 90 º at 
the resonant frequency value. FYI, the Amp, Freq and Q 
values at the top of the panel are the values found for the 
largest peak within the Sweep width (in Figure 16’s case, 5 
kHz). 
 

 
 
 
 
 

 
 
▪ If you don’t have any idea what the resonant frequency is of your cantilever but want to, perform 
a thermal tune first to determine the resonant frequency of the cantilever, as described in the 
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previous Section VI. Examples can be seen in Figure 13 [air] or 14 [fluid]; Bring up the cursors 
with Crtl + I , and select the frequency of the fundamental peak; As long as this number fits within 
the Auto Tune high and low values; click the ‘Auto Tune’, and the software will determine the 
Drive Frequency. If not, adjust the Auto Tune high and low values accordingly. 
 
Tip Engagement: Once a Drive Frequency has been determined, adjust the following 
parameters, and you’ll be ready to engage the tip. 

Because the Auto Tune automatically adjusts the ‘Free Air’ amplitude to 1.00 V, adjust the Set 
Point Voltage about 20% less than that (i.e 800 mV, the default value). To get a better 
understanding of this relation, see Figure 17. 

Adjust I gain to 5 to 10  
Click the ‘Simple Engage’ Button on the S&D meter, and wheel the thumbwheel on the front 

of the MFP-3D head counterclockwise. As the tip nears the surface, you will notice the amplitude 
value on the S&D meter decrease, until it reaches the same voltage as your user defined set 
point. At this point, there is a chime sound, and the Z piezo voltage will go from 150 V, to some 
lesser value (less red on the S&D meter). 

Begin imaging; make sure proper image channels are set in Master Channel Panel (see 
Section IV, page 8) 

 
▪ While monitoring the images and scan (re)traces, tune imaging parameters (set point, drive 
amplitude, scan rate, I gain) to obtain best image quality.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Gentle Engagement: If you want to engage at the very lowest set point possible (because of 
modified tip, or an expensive, super-sharp tip) the MFP-3D is perfect for it. Here’s how to do it: 

Perform an Auto Tune 
Set the set point voltage for about 5% of the free air amplitude voltage (i.e, for a 1.0 V free air, 

use set point of 950 mV) 
Engage as you normally would. However, this engagement is a false engagement- the tip is 

engaging on the (inherent) water layer on the sample. Adjust the Z piezo voltage to 30 to 50 V 
(halfway blue). You can see the Z piezo voltage seems to kind of float as you move the 
thumbwheel. 

With the radio label for the set point activated, use the Hamster wheel to increase the force 
(decrease set point voltage value); the Z piezo voltage will move to some larger voltage value 

Figure 17: (Qualitative) Conceptual amplitude voltage vs. distance for AC Mode imaging. Lower set point values 
result in higher tip-sample force; higher set point values result in lower tip-sample forces. This is not to scale and not 
real data. 
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(more red). At some point, you will see a ‘hard’ engagement in the Z piezo; continuing to decrease 
the set point value, you’ll notice the Z piezo will no longer move to some more positive value.  
▪ At the point of this ‘hard’ engagement, the tip has engaged at the lowest possible set point force, 
therefore preserving the tip shape. 
 
 
AC mode Phase Monitoring: To prevent ‘mode hopping’ while imaging, you can monitor the 
phase of the oscillating cantilever during imaging. Mode hopping occurs when imaging switches 
between intermittent contact (attractive) and non-contact modes (repulsive). This works well in 
air, but doesn’t hold as true in fluid. Mode hopping occurs when the Phase flips between < 90° 
and > 90°; resulting in kind of crappy images (that’s a technical term). 
 
▪ The sine of the phase (at constant amplitude) is the tip-sample dissipation. But sine is 
symmetric: sin(80°) = sin(100°). Thus, there are always two phase angles consistent with a given 
dissipation. So the second important part is whether the phase is above or below 90°.  
Take home message: Phase > 90° (attractive or low-amplitude mode) is very different than Phase 
< 90° (repulsive or high-amplitude mode). The colors represent what color the phase value regime 
will be in the S & D meter. (text courtesy of Jason Cleveland) 
 
▪ When AC imaging in air, you can following if the tip is net attractive or net repulsive forces with 

the surface by monitoring the phase value in the S & D meter. Typically, you have to go into 
‘setup’ window, use the pull down menu next to Phase and choose ‘On’ from ‘auto’.  

▪ If the phase is < 90 º (blue) it’s in the repulsive regime; when its > 90 º (red), it’s in the 
attractive regime.  This gets more complicated in fluid, so I am not suggesting you follow this 
trend in anything other than air. The following table was prepared to help you adjust your imaging 
or experimental parameters to eliminate mode hopping. 

 
Attractive mode Repulsive mode 
> 90 º < 90 º 
High Q Low Q 
Lower amplitude (Reduce A fa)  Lower amplitude (Increase A fa) 
Increase Asp/ Afa Decrease Asp/ Afa 
Larger tip radius Smaller tip radius 
Set f > fo Set f < fo 

where Afa is the free air amplitude (in volts);  
and Asp is the set point (in volts)  
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VIIB. AC mode IN FLUID: 
 
▪ The MFP-3D is designed to work in fluid very well. The procedure for tuning the cantilever is 
almost is as easy as in air, but differs slightly…. 

 
Determining Drive Frequency In Fluid: There are two ways to determine a Drive Frequency for 
AC mode imaging: the first is a bit more refined than the second, but you can pretty much get to 
the same parameters following both.  

 
1) AR has worked a nice protocol into their software in which you can overlay the thermal power 
spectrum over the frequency sweep, which allows you to determine a precise drive frequency (see 
Figure 18 below) which is associated with cantilever’s natural resonant frequency. 
 

 Determine a range to do the frequency sweep from performing a thermal tune; 
 In the Tune Tab, click the ‘Append Thermal’  checkbox;  
 Click the ‘One Tune’ button (with the proper frequency range selected); After the sweep, you’ll 

see a frequency plot (black trace) over top the thermal power spectrum (red scatter points).  
 Using the cross cursor, right click at the most pronounced peak that corresponds to the left side 

to maximum of the resonant peak on the thermal tune scatter plot (red). A dialogue comes up 
(after you right click); choose ‘Set drive frequency as’; this updates the drive frequency.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Click the ‘Center Phase’ button once a drive frequency has been determined. This will center 

the phase at 90 degrees, which you can see in the S & D meter. This allows you to monitor 
whether the tip is in the attractive or repulsive regime, however, this doesn’t hold as true in fluid as 
it does in air (Section VII). 
 

Change the R filter: Go to Programming → make filter panel. A new window pops up: change 
R filter from 1.5 to 0.5 Hz. 

 

Figure 18: Results from a ‘One Tune’ frequency sweep in fluid with 
appended thermal tune (red points).The black vertical line indicates the 
user defined drive frequency. 
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Figure 19: Thermal tune Freq vs. amplitude plot IN 
FLUID. Peaks become broader due to lower ‘Q’ 
value, and resonant peaks to lower frequency. 

Select imaging parameters and you’ll be ready to Engage 
 
▪Choose the set point similar to the description in previous section: 

 Look at the ‘free air’/ non-engaged Drive amplitude in the Sum & Deflection window. (See 
Figure 17, plateau part of curve)  

 Choose a set point that is lower than that (some percentage, in volts); If you want to engage 
gently, make the set point 85 to 95 %.  

 Click ‘Simple Engage’ on the sum and deflection meter top and manually thumb the approach 
wheel until the feedback servo is activated (as described above). 
Typically in fluids, the drive amplitude will have to be somewhat high to avoid a false engagement 
(Z piezo goes all the way blue (-10 V) - because it thinks it has crashed).  

 
NOTE: When imaging in fluid, there are a few things you have to look out for 
(depending on your cantilever’s floppiness).  
-False engagement will occur if the set point isn’t low enough, and /or the drive 
amplitude isn’t high. My experience for imaging some proteins has been drive 
amplitudes of 1800 mV and set points of 200 mV. Picking the second quasi harmonic 
can result in larger drive frequencies to circumvent this false engagement issue.  
-Change filter: Go to Programming → make filter panel. A new window pops up: change 
R filter from 1.5 to 0.5 Hz. 
-You can also change the Q gain in the ‘Tune’ tab. I have had limited experience / 
success with this feature. 

 
 As you thumbwheel down, you will notice that the amplitude value is increasing. This is 

(believed to) because of the liquid being compressed between the tip and sample as it 
approaches. Use the Hamster wheel to decrease the amplitude to pre-approach value to maintain 
the proper set point % of the ‘free air’ amplitude. As the tip gets very close to the surface, you will 
notice the amplitude decrease, and will engage at the set point value you defined.  

 Move piezo into middle of Z range; 
 tune parameters as described above. 
 

2) Alternatively, you can follow this 
procedure if you have difficulty getting a 
decent image from the above protocol. From 
the Thermal (power spectrum) plot, place an 
Igor cursor on the left side of the first or 
second peak, about 5 to 10% of the 
maximum amplitude. The areas indicated by 
the red arrow(s) are where you can manually 
pick the drive frequencies by entering the ‘X’ 
cursor value in the drive frequency window of 
the Tune tab. Notice the second peak is a 
Eigen frequency. 
 
 
 
 

 Engage as you normally would; 
 Once imaging, you can also adjust the Drive Frequency with the Hamster wheel until you find 

the sweet spot. 
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 Figure 20 shows the results of changing the drive frequency on the fly to find the ‘sweet spot’. 

During parameter tuning, monitor the image quality in the height and phase images, as well as the 
scan traces below the height image. The Phase image can be monitored for noise as seen in the 
left image. A slight adjustment reduces this noise for better image quality. The image is of a 
protein pattern (lighter color), and poly ethylene glycol terminated thiolate (dark region). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

VIII. Shut Down / Scanning Cessation: 
 

▪ When you are done imaging: 
Click the ‘Stop!!!’ button to withdraw the tip (S&D meter piezo reads 0.0 V).  
Retract thumbwheel some (clockwise turn) and turn off SLD- turn key counterclockwise!  
Turn off ccd camera window and camera fiber optic light.  
Remove sample from stage, and tip from tip holder.  
If operating in Buffer, rinse tip holder off with water to remove salts. Dry in stream of N2.  
Leave Controller and PC running unless expecting power outage. 
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Figure 20: Monitoring the Phase image while changing the drive Frequency on the fly. 
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Figure 21: Trigger Channels 

Figure 22: Force Tab showing Calibration 
Tab 

IX. Force Spectroscopy/ FORCE CURVE AQUISITION: 
Force – distance curves can be acquired by a variety of ways. The first step to acquiring an 
accurate force distance curve is to determine the spring constant of a cantilever on a clean hard 
surface. (Section IV).  
▪ To reiterate: 

 Select Contact mode (Main Tab) 
 In Force Tab (Figure 9 or 22)- Set Trigger to DeflVolts (Figure 21);  
 Activate ‘Relative’ Radio button; 
 Choose a (piezo) velocity and Force distance; (like 1 µm/s and 600 nm to 1 µm) 
 Hit the ‘Single Force’ button; this gives a Force curve and Force Channel Panel (see Figure 23 

and description below) 
 Determine InvOLS of contact region (place cursors; select ‘Deflection’ under Set Sens pull 

down) 
 Withdraw tip; 
 Perform a Thermal tune; 
 Fit curve; spring constant determined 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
▪ Once k is determined, the trigger channel can be 
switched to deflection (or Force) from the pull down 
menu, and a distance (or Force) value can be entered (if 
you are comfortable with this dimension). Figure 21 
shows all channels you that can be selected for a trigger 
point:  
 
▪ Force Curves are acquired individually by clicking 
‘Single Force’, or continuously by hitting the 
‘Continuous’ button. The amount of continuous curves 
can be limited by going to ‘Setup’ → ‘Limit Contin. To’  
checkbox, and click ‘Looks Good’. Enter amount of 
curves you want to collect continuously, and do some 
force spectroscopy. 
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Figure 24: Sync mode allows different 
piezo approach and retract velocities 

 
Force Channel Panel: This panel changes the data 
channels displayed and saved in Force Plots. 
The Green / Blue / Red LEDS to the left of the channels 
describe the settings of those channels. 
Red = Channel is not on. 
Blue = Channel is ONLY displayed 
Green = Channel is saved (does not care if channel is 
displayed or not). 
 
▪ up to 5 channels can be plotted simultaneously.  
 
The Force Channel help menu is very informative 
 
 
 
▪ Red / Blue mode: (forward & reverse pulls) 
Red Mode: (forward pull) tip starts cycle at surface and 
travels to free air, then returns to surface 
Blue mode: (reverse pull) tip starts cycle in free air and 
approaches surface; then retracts 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
▪ Split/ Sync piezo velocity modes: This button allows the 
user to select different approach and retract piezo velocities 
(figure 24). 

 
 

 
 
▪ Trigger points: The ‘Trigger point’ is a user defined value detected on the PSD that tells the 
piezo to switch directions even if the force (deflection) curve hasn’t achieved the completed Force 
distance (deflection) value.  

Activate it by choosing what channel you want it to trigger on (Figure 21); (for example, I like to 
use the ‘deflection’ channel which will be in nm; alternatively, your can choose DeflVolts, which 
will be in Volts, or Force in Newtons)  

Blue activation 

Red activation 

Figure 23: Force Channel Panel 
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Type in your desired trigger value; (just don’t pick femptometers) 
Select what kind of trigger you want; the difference between the two are- 

Absolute trigger is/was the default trigger: My understanding it takes whatever trigger value you 
choose and adds it to what ever the free air deflection happens to be. What you get is Force 
curves with larger deflections (or other channel) plotted then you might expect. (absolute is (1) in 
parameter file list) 

 
Relative trigger is more sensitive and should be used for more accurate force distance curve 
acquisition. You have to play with the trigger point here because a very low one can put you down 
in the noise level of your system/ cantilever. Figure 25 below is an example of two curves obtained 
with different absolute trigger points. The upper curve (red) has a lower trigger point than the 
lower (black). Low relative trigger values appear noisy because they are auto scaled in the y axis. 
(relative trigger is (0) in parameter file list) 

 
 
NOTE: Whatever Trigger you are using, if your tip is modified, it a good idea to use low 
trigger values to prevent unnecessary grinding of the tip into the surface during contact. 

 
 
 

 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
The Misc. Tab: (Figure 26) this is where the tip (piezo) 
dwell setting can be varied. In blue mode, this lets the tip 
dwell at trigger point (if one) for a defined amount of time 
before continuing through the retract motion. 
▪ Dwell time and filters settings can be chosen here. 
▪ In Red mode, the dwell occurs away from surface 
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Figure 25: Relative Triggers in deflection channel: 3 nm (red); 15 nm (black) 

Figure 26: Misc. Tab of Force Channel Panel 
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Figure 27: Calibrating ‘virtual’ deflection: upon the first force curve acquired, place 
cursors on free air part of curve. B) go to Set Sens pull-down and choose ‘Virtual 
Defl.’ C) free air part of curve is fitted (black line). Force distance curves after this will 
have ‘level’ free air approach/ retract data 

The Calibration Tab: In this tab, the Defl InvOLS, AmpInvOLS, or virtual Deflection should be 
calibrated upon an initial force-distance curve. The former two have already been discussed in 
Section IV. 

 
▪ Virtual Deflection Calibration: The virtual deflection correction essentially ‘levels’ the free air 
part of the force-distance curve. This can make curve analysis easier; for example some rely on 
an analysis that averages some section of the free air to find the contact point of the retract. This 
virtual deflection is a result of the mechanical path not being quite perfect, resulting in a slight 
slope in the force curve. Notice that this may only be a few nm’s over several microns!....but if not 
corrected, it can make a difference in measurement or analysis. 
 
Procedure: 
With low force distance value,  

Click ‘Single Force’ button; Force curve should like similar to one in Figure 27A; a long free air 
in the approach curve is desired so you can fit a linear region of it. 

place the Igor cursors (Crtl + I) on linear part of free air approach 
go to ‘Set Sens’ pull down menu in Cal. Tab (Figure 27B)- select Virtual Defl.;  

▪ This calibrates the virtual deflection so you have ‘level’ looking free air portions of your force 
curves. 
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Tip location dot 

Figure 29: Point and click Force curves 

Figure 28: ‘Go There’ Force tab 

 
The ‘Go There’ Tab: This is where the user can designate 
points on an image for force curves. This is very useful when you 
have imaged the surface and want to immediately acquire force 
curves at specific points/features on your image. The MFP-3D’s 
closed loop makes the accuracy possible. 
 
Procedure: 

Acquire image in AC or Contact mode 
Use the ‘Go There’ tab in the Force tab (Figure 28); 
Under spot display pull-down, choose ‘Numbered Markers’; 
 Also check the ‘Show Tip Location’ box; a red dot will appear 

on the image. 
 Drag the ⊗ symbol (from lower left) to the desired location; 
Click on the ‘That’s It!’ button; which locks 

the point at that spot, meanwhile the point 
number index is advanced one in 
anticipation of the next point being chosen; 

When finished, you can enter what point 
you to return to for force curve acquisition, 
hit ‘Go There’ button. The red dot should 
move to that cross hair (see point 1 in Figure 
29).  

 
 

 
NOTE: Every time a new file name 
is chosen, the numbered markers 
will refresh and you have to pick 
points over again.  
 
 
 
 
 
 
 
 
 
 

Force curves can be monitored with the headphones. This is great for a variety of reasons: 
You can have the headphone volume up to listen/monitor to the force-distance cycles while 
you work one something else across the room. Large (non-specific) multiple events curves 
can be heard through a sort of ‘ripping’ sound when working with bio systems; or you can 
hear if the tip comes off the surface by a constant static noise (as opposed to static, 
dampen, static sound of a regular force-distance cycle). 
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▪ Force Volume Mapping: Chad Ray (Duke Chemistry) has written a macro to acquire force 
distance curves in an array. Contact AR (Support@AsylumResearch.com to acquire this 
procedure).  

Activate by going to programming→ load user functions → UserChad0. It will load a window 
(Figure 30). 

choose the array size (keep number of points and lines and equal value), and what output you 
want the y-axis to display (i.e, Force, deflection). 

leave all other parameters in their default settings.  
This procedure will also export curves to text files by clicking the ‘Export Curves’ button. This 

creates a new folder called ‘export’ in the folder where your .ibw waves are in a comma delimited 
formatted. This is great for exporting lots of curves in a batch type file. 
‘One Note’  makes only one parameter header in that specific folder full of ibw’s 
 
This procedure is very good. Chad has incorporated a feature called ‘Update Start Dist  
checkbox that automatically adjusts the start distance as the tip traverses the sample collecting 
the array. This way you don’t have to be concerned about the tip not making contact because the 
surface is not level. 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

▪ For force curve analysis, see Section X 

Figure 30: Chad Ray’s Force Volume 
Mapping acquisition ipf 
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Figure 31: Left: ‘Browse’ dialog box for image recall; Right: Path to Load Dialog- change data folders here 

 
X. OFFLINE DATA ANALYSIS: 

NOTE: This analysis has a lot of options, so I describe what I have primarily used in efforts to 
possibly aid a new user. I suggest exploring this software to get a sense of its flexibility and 
power. 
 

Image Analysis: 
Click on ‘Browse Images’ in the Main tab. A Path Dialog (Figure 31A) will come up asking what 

directory to load images from. By clicking ‘That’s It’, is like clicking return b/c the path is 
acceptable. If you want to change folders, click the ‘Browse’ button. A new dialog comes up 
(Figure 31B); by clicking the ‘Browse’ button in this dialog, you can change folders. Final selection 
made by clicking ‘OK’.  

 
 
 
 
 
 
 
 

 
▪ From here, a thumbnail ‘Browse’ window comes up, along with a ‘List’ panel- you can choose 
images from either.  

 
▪ The List panel (not shown) is convenient for saving ‘real estate’ space on the monitor(s) screen; 
just file names are shown, plus some options like change directory, etc.  

 
▪ The Browse window shows the image files in thumbnail form & has more features (Figure 32). 
You can choose the size, data type, trace or retrace, etc. 

 
 
 
 
 
 
 
 
 
 
 
 
 
Double clicking on file (or image), calls up a stored file. 
 

▪ Once you choose a file, the image comes up with a bunch of analysis function buttons, range 
value windows, and pull-down menus (Figure 33). It’s called a ‘display window’. 

 
 
 
 

Figure 32: The display options of the Browse panel 
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Figure 33:Display Window: un modified, off-line image recalled 

 
▪ The tabs in the display window above the 
image represent the saved data channels. 
Figure 33 shows height Trace & retrace 
(HtT, HtR), Amplitude, Phase, Z sensor. 
 
▪ The z range can be manually adjusted, or 
auto scales by clicking the ‘Auto’ button; 
similarly, the z scale offset can be 
adjusted. 
 
▪ The options under the Command pull 
down will be discussed below.  
 
▪ The ColorMap pull-down gives you a lot 
of color options; including creating custom 
color maps. 

 
 
 
 
 
 

 
 

▪ At the upper left of the image window, you will see a series of small boxes with letters in them 
(3D, D, L, A, M). They represent the following- 

 
 

Modify Panel- (Figure 34) This panel is essentially contains the image flattening 
functions- 

 
▪ Under the Flatten tab, you can exclude part of the image by clicking ‘Exclude Points’ or 
‘Include Points’, which brings up a tool box (right) that has lots of shapes to use to make 
areas that won’t be included in the area flattened. When activating some of these shapes, 
black squares on its periphery define it, to move, use arrows keys. If you mouse click on it 
again, it becomes fixed.  
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 34: The tabs of the Modify Panel 
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▪ Alternatively, by going to the ‘Mask’ tab, more complex shapes can by masked out. I think of the 
Mask function as something that with exclude all points/pixels in the x-, y- plane above a certain z- 
threshold. Using the image above as a very simple example, the process is demonstrated: 

 
In the Flatten panel, click the ‘Flatten’ button, with 0 or 1st order flatten (from pull down menu); 

the following image occurs (Figure 35A); Notice the dark lines between the circular features  
To remove these flattening artifacts, go to the ‘Mask’ tab; choose ‘Iterative’ from the Calc 

method pull down; this automatically gives you the z- range the operation chose. after this 
calculation, ‘manual’ calc method automatically appears (Figure 35B) 

Change threshold to some value that better represents surface threshold 
Go back to Flatten tab; click Flatten again to get result similar to Figure 35C 
Click ‘Reset Mask’ button to remove red lines 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

▪ Tabs above the image with a *0 suffix indicate modification to that image. Selecting ‘Save Image’ 
in the Commands pull-down will save this modification to the file; the raw data will still be there. 

 
▪ The Modified image can be saved a number of ways: 1) by going to the command pull down 
menu and selecting one of the many tiff export options, or save image. 2) By going to File→Save 
Graphics  

 
NOTE: you must have a path chosen ahead of time to tell the software where to save 
modified image. This is described more below in ‘Tricks’ section. 

 
 

▪ The Planefit tab does a plane fit on the image; chose x- plane with ‘X’ button; y- with ‘Y’ button, 
or x-, y- with ‘XY’ button 
▪ The Erase tab is where aberrant, noisy (slow) scan lines can be eliminated from the image 

Click on the ‘Draw Lines’ Button, a little hand  comes up- use tip of index finger to place where 
you want to erase scan line; sometimes you have to increase the ‘line width’ value 

Figure 35: flatten, mask, flatten process to remove flattening artifacts. A) 0 order flatten; B) Mask tab options; C) post mask 
Flatten with mask definition still present 

A C B 
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Figure 36: the Section tab of the Analysis Panel 

 Click ‘Erase Lines’ to execute 
 ‘Clear Lines’ gets rid of the red line 

 
▪ RF is still not familiar with the FFT and Filter tabs 

 
 

Analyze Panel: This is where the RMS data, line section and image histogram stuff can be 
found.  
Click on the ‘A’ button at the top of the image 

The Roughness tab: This tab will give RMS, and associated stats. You can also you the masking 
feature to calculate areas, or RMS of the masked area, or RMS of with the masked area excluded. 

 
The Section Tab: (Figure 36) 

to draw a line for section analysis, click on the ‘Draw’ button; go to the image and draw the line 
in the desired location on image; 
 on the image, hold the mouse button down over the 
Igor cursor and draw the line through the desired areas 
for section analysis. 
▪ Lines can be averaged by entering a value for ‘Width’.  

Straight or free hand lines can be chosen by selecting 
from the Mode pull-down menu. 
▪ Line angles can be locked in by designating user 
defined angle 
▪ Up to 10 different sections can be made in an off line 
analysis:  

use section # pull-down to activate new one;  
designate line color with color pull-down 
repeat line drawing process; multiple lines are 

displayed on same section plot 
 
▪ With the Full  checkbox checked, the entire line 
will be shown in the section plot; if unchecked, only 
distance between cursors on image will be shown 

 
▪ Cursor Drive: with this radio label activated, you 
can adjust the position of the line after it has been 
drawn (Figure 37); click on cursor (i.e, ⌧) and pull 
to new location. Line and section plot are updated. 
 
▪ Cursor Measure: with this radio label activated, 
you can measure distances on Sections Plot. Move 
the cursors on the section plot to the desired 
location. The cursors will move also on the image.   
 
▪ to use the section tool on real time scans, go to 
MFP IP → Analyze Panel; select the real time  checkbox; Use procedure described above. 
 
 
 
 

Figure 37: Cursor Drive 

Before After 
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Exporting Line sections: In the line section graph panel that comes up, click the ‘Edit’ button, 
which brings up a new table with one column of data in it. ‘Kill’ it.  

go to Windows → New Table.  
Select the four waves in the ‘Columns to edit’ that end with the following suffixes: 
(Filename-suffix) lHtT, QHtT, XHtT & _HtT; click ‘Do It’;  (FYI: the ‘T’ stands for the Trace)                     
Data, Retrace data would have an ‘R’ suffix) 

▪ A new table comes up that has two columns that you can export to another spreadsheet, or use 
in Igor. 

 
Clicking this ‘D’ button brings up the ‘Display manager’- this helps organize display windows 
when many are open. There is a great description in the help file. 

 
 

Clicking the ‘L’ button brings up the List panel, the same that is presented after selecting a 
file to browse. 

 
 
 

The Command Menu: There are many features in here: 
▪ Modify, Analyze, Display and list do the same thing as what was just 
described above. 
▪ Extract/ Insert / Delete Layer: 
▪ Show Note: this is where all the imaging parameter information is. 

Incidentally, the following binaries mean- 
Scan down 1: downscan; slow scan goes from top of image window to bottom 
Scan down 0: up scan; slow scan goes from bottom of image window to top 
Imaging Modes: Contact 0; AC: 1 

▪ Change User Names: 
▪ Save image- after modifying an image, clicking this will save that modified 
work under a new *0 tab 
▪ Save Then Kill Image: same as above, but closes it too 
▪ Kill Image: closes image 
TIFF Exports- 1x, 2x, 4x refers to image size 
▪ Crop Image- to crop an image, used the mouse to Expand on an area; then 
click on ‘Crop Image’- this will make image that size of expanded area (i.e, 
Crtl + A doesn’t take you back). Before using this feature, I like to make a 
copy of that file, just so I have the original raw data. 
▪ Setup 
▪ Help 

 
 
 
 
 
 
 
 
 
 
 

Commands 



Ryan’s MFP-3D™ Operation Manualette, Version IX 9/2006 33

Figure 38: Master ARgyle Panel 

Figure 39: A) 2D image; B) initial ARgyle image; C) after ‘Zoom’ Z scale adjustment, new color 
map and adding specular lighting. 

 
 
ARgyle three dimensional display: brief introduction 
 
Clicking the ‘3D’ button in the display window brings up the ARgyle software feature. This lets 
you plot saved images, or real time scans, in a (quasi) 3D rendering. The menu is vast, so I 
suggest exploring these parameters on your own. However, just to get you started, I have an 
example of how I use it to look decent. I am by no means an ARgyle expert.  
 
 Start with appropriately flattening an 

image  
 Click on the 3D button; the ARglye menu 

(Figure 38) and the 3D image will come up. 
Notice the z scale is huge. 
 
 
 
 
 
▪ Notice that holding the left mouse button down while in the 3D image rotates the image 

 Go to the View tab; and select ‘Zoom’ from the pull-down menu. Use the right hand bar to lower 
the Z Scale to a manageable value (for my stuff, I like 0.03). Alternatively, you can click the Aspect 
1  checkbox which scales the Z range relative to the X and Y dimensions (quite often this makes 
it look flat, but this is good for image overlay- see Section XII, page 40).  
Figure 39 shows the progression described above- 

 
 

 
 Adjust other values such as the Data scale values, light rotation, zoom and offset. Color map 

found in ‘Display’ tab; background color found under ‘Prefs’ tab; Specular lighting occurs in the 
‘Lights’ tab – click the shiny  checkbox 
 
Hotkeys: Crtl + the mouse does zoom; Shift + mouse does offset 

 
▪ To export images from ARgyle, make the 3D image window the forward-most image (active 
window), Copy to clipboard, and dump into another program (Paint, Photoshop, PowerPoint, etc.) 
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▪ To plot a real time image in 3D, go to MFP IP → 3D surface plots; this brings up the ARgyle 
Master Panel (Figure 38). From the pull down menu under the ‘New’ tab, select RealTime and 
click the ‘Do It’ button. 
▪ You can also make movies with your ARgyle image. Contact Support@AsylumResearch for this 
instruction file (Bruce Wallace). 
 
Force Curve Analysis: 
Do to this panel’s versatility, the help menus are pretty helpful 

 
▪ In the Force tab of the Master Panel, clicking the 
‘Review’ button brings up the Master Force Panel 
(Figure 40).  

 
▪ Load up some Force distance curves. Clicking 
‘Load Curves’ in the Display tab of the Master 
Force Panel will also get you there. This will put all 
the curves in that folder, which could be a data set. 
 
The ‘Display’ tab lets you choose what channel 
you want your data displayed (i.e, Force, 
deflection), how many axis, extension, retraction 
part of the curve. The ‘Show Notes’ button brings 
up a table with all the experimental parameters 
associated with that file.  

 
The y- axis can be chosen at the top (deflection, 
force, etc. 
 
▪ Individual curves can be advanced by clicking the 
‘<’ or ‘>’ buttons; ‘<10’ and ‘>10’ advance 10 slides 
ahead (or back); and ‘Rand’ randomly pick curves; 
the ‘+’  adds the next curve in the file and overlays 
it on the force plot; ‘–‘ removes one 
 
▪ The filenames are displayed in the window at the 
bottom. Clicking on one brings that force curve up: 
holding the ‘shift’ key down lets you choose 
multiples.  
 
▪ When ready to load new data set, delete loaded 
curves by clicking ‘Delete All’- if you don’t and 
load more curves, those curves will included in any analysis you do (i.e, a histogram) 
 
▪ Clicking the ‘Edit’ button in the ‘Force Review Graph’ brings up a table with the points (if you 
want to copy it and dump it into another spreadsheet) 

 
The ‘Parm’ tab tells you the parameters of a file. There are a series of pull down menus that lets 
you customize the panel to show only specific parameters  
 
The ‘Cursor’ tab- I am not really sure what this does 

Figure 40: Master Force Panel 
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The ‘Modify’ tab allows you to zero the curve with respect to X and/or Y, individual curves or all 
the curves in the data set. I am not familiar with the actions of the ‘Line Subtract’ button.  
 
The ‘WLC’ tab calculates worm like chain model for curves with multiple events. The instructions 
for the analysis are located on AR’s web page under the support → MFP3D FAQ section (This 
FAQ webpage has some good stuff on it). 

 
The ‘Analyze’ tab allows you to generate histograms and scatter plots of adhesion data (select 
from pull down menu). The histogram window has a feature in which you can fit Guassian, 
Poisson or Lorentzian curve to it. (Sometimes you have to stretch the window out to see this 
feature on the right hand side of the window) Clicking ‘Edit’ brings up a table with the histogram 
points in it. The number of bins can also be adjusted with a slider bar.  

 
NOTE: The procedure for this calculation is that is averages the last five or 10 points of 
the retraction curve, and finds the difference between that and the minimum of the 
retraction curve. In other words, the histogram represents only the largest single event in 
each curve. If you have curves with multiple events that you are concerned about, this 
histogram will not be representative of your data set. 

 
 

The Spot tab correlates individual force curves to surface features on an image that you ‘picked 
points’ from. It places the force curve suffix respective to their position on the image. 
 
My description of the Master Force panel are brief; More complicated questions can be directed to 
Support@ where someone where more seasoned force spectroscopists who wrote the software 
code can answer your questions. 
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XI. Empirical Tricks: Stuff I’ve learned along the way for better imaging. 
 

▪ Imaging in fluids- PRECAUTIONS: 
When imaging in fluids, it is important not to allow buffer to get to scanner, or you have a 
$9000 problem, minimum. What can happen is that fluid can fall down onto the top of the 
stage, get sucked into the bottom of the scanner through the back plate via capillary action, 
then into the flexor channel via capillary action. Fluid can ruin the LVDT sensors and 
compromise (corrode) the flexor channels from moving properly.  
 
IF YOU DON’T HAVE A CLOSED FLUID CELL: To protect the scanner, place a piece of 
plastic under the sample (see Figure 41B below).  Also make a reservoir around sample. This 
can be done a variety of ways: I have found that a silicone based adhesive works pretty well to 
fabricate a make shift fluid barrier on a glass slide. I put a small amount of the adhesive into a 
5 mL syringe so I can control the amount coming out, much like what is used when piping 
frosting onto a cake. I also draw a template onto a piece of paper to get consistent sizes during 
application (Figure 41A). When choosing a silicone, check the ingredients to insure the 
solvents won’t interfere with your sample. Alternatively, a slice of glass tube stock can be 
adhered to a glass slide (shown in right figure below). PAP pens can also be used to create a 
hydrophobic barrier around your sample, but they are more expensive. There are Teflon 
coated standard microscope slides with circular bare glass regions that could also be used 
(Figure 41C). A variety of these slides can be purchased from the EMS website below. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Plastic under sample offers more protection  against 
fluid reaching bottom side of scanner. 

www.emsdiasum.com/microscopy/products/histology/slides.aspx#63414 

Figure 41: Cost effective alternatives to keeping the X,Y scanner dry when working in fluid. 
A) silicone barriers; B) glass tube stock; C) Teflon coated slides (from Electron Microscopy 
Sciences) 

A B 

C 
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▪ ‘Gentle’ engagement: I learned this from Chad Ray (Achremitchev group; Duke Chemistry) 
This is a good approach for a very gentle engagement (i.e, you have bio-modified tip); Tune 
cantilever in AC mode, like you are going to image with it; start approaching with the thumbwheel. 
Wheel down 10 µm, then do a ‘Simple Engage’; if the tip doesn’t engage, hit ‘Stop!’, wheel down 
another 10 µm, and repeat. Once engaged, you can use the micron graduation on the 
thumbwheel to adjust to the middle of the piezo when the tip is engaged. Once this is done, you 
can disengage with ‘Stop’ button and switch to contact mode to do force curves, or whatever you 
want to do. 

 
Alternatively, you can choose an AC mode set point that is ~5% of the free air amplitude, hit 
simple engage, wheel down until engagement (which should be a false engagement); move to 
some more retracted Z value (1/2 blue). Then use the hamster (with the set point radio button 
activated) to dial in a lower set point (smaller voltage value). You’ll see some movement in the z- 
piezo movement, but since it’s under feedback and the AR has super-fast electronics, you can 
adjust the thumbwheel to your desired piezo value. When it truly engages, you’ll see a sudden 
snap in the Z piezo movement (sum & deflection meter), and then it won’t move anymore with 
decreasing set point. This method works great, and is efficient. 

 
Both methods offer the tip to engage under a more controlled feedback. 

 
▪ Getting Biolevers™ to stay extended (not folded under chip) after wetting: 

 
Grab chip at opposite end with negative tweezers. Rinse with EtOH or water such that liquid flow 
falls over adhered tips (usually on under side of chip- reflective side); Gently tap tweezers against 
desk to free adhered tips. Blot dry with Chem.Wipe. 
Many times, a biolever will pop back when in the fluid meniscus between tip holder and sample; it 
may take several minutes for this to occur. 
Icidentally, AR application scientisthave discovered if the small biolevers have resonant 
frequencies below 7 or 8 kHz in fluid, the changes of them imaging well are greatly reduced. We 
suspect this is an Olypmus QC issue. 
 
▪ Reducing noise in your system: I have discovered that keeping anything with a cooling fan off 
the desk that your controller is on. These items can translate their mechanical noise through the 
monster cable if all on the same desk. Our lab have a system from 2004 when AR was using a 
more rigid monster cable, which can transfer mechanical noise along it. In efforts to reduce this 
noise, I have sandwiched it between to 50 lb. bags of sand. 
 
▪ Adhering samples to slides: Asylum Research urges users not to use two sided tape because 
of the inherent creep and compliance that is associated with it. Superglue, or a 5 minute epoxy 
works very well. However, solvent volatility in these products can compromise a sample, 
especially if you have a wet biological sample that has to stay wet. In this case, some Dow 
Corning vacuum grease works well – put into a syringe barrel as a way to dispense it. 
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XII. Miscellaneous Software Procedures  
 
 

▪ Saving Graphics: First you must ‘Create a path’: 
Misc → New Path… ; create name, and then choose a path (the folder you are going to want stuff 
dumped when you save it) 
Then bring what you want to save an image of as the forward-most window. File → Save Graphics 
…: dialogue comes up in which you can choose what kind of file you want to save image as, 
actual dimensions, name. Also, this is where you choose the path that you just created in the 
‘path’ pull down menu. Otherwise, it gets dumped deep within the bowels of the Wavemetrics 
folder in the program files. 

 
 

▪ Capturing images from ccd camera (top down camera 
model only): 

Click ‘capture’ button on camera window. 
Go to Data → data browser; right click on capture, select 

new image. This produces a new window with an image in 
it.  

save this image by going to file → save graphics; save in 
what ever format & size & resolution you want (remember 
that you need to first designate a place to put your data by 
going Misc → new path; select path and click ‘do it’).  
▪ It’s best to rename each image you capture, before you 
capture another.  

 
NOTE: It’s been my experience that if you magnify 
your ccd image before clicking capture, it won’t make an image. You must first capture 
an image un-magnified before capturing ccd images that are magnified. Also, the ‘New 
Image’ is inverted vertically. 
 

 
▪ Exporting curves to .txt format: 
-create a place to dump the curves for them → someplace that will show up in the path box in the 
‘save delimited text’ dialogue box. 

 
Go to Misc → New Path  
 make Filename of your choice; 
click ‘path’ → choose where you want to dump it;  
click ‘Do it’ 

 
1) Exporting single waves- 
Note: go to data folders → click review force curve  checkbox 

 
Go to data → load waves → Igor binary: brings up browsing dialog 

-select the curve you want, then a new dialogue asking if you want to copy, and 
you say ‘OK’ 
Data → SaveWaves → Save delimited text 
-find wave name in Wave(s) menu & choose path in ‘Path’ box; click ‘Do it’ 



Ryan’s MFP-3D™ Operation Manualette, Version IX 9/2006 39

-check to see if it’s there (and tab delimited), by going to the place where you 
dumped it. (Open it w/ notepad to make sure its tab delimited) 
 

2) Exporting as Batch file: 
 
The easiest way I know is to use Chad Ray’s Force Volume Mapping macro; you 
can do it a lot quicker with his program. The name of the program is Chad0. 
Contact support@asylumresearch.com for the ipf file. 
 
Go to MFP controls → Force Mapping 
-this brings up a small dialogue with a Duke logo 
-click on ‘Export‘, choose place where you want curves to get dumped 
-click on ‘export’ button; look for the 0 processing thing in the lower left of the 
MFP3D window.  
This feature automatically creates an export folder in the same folder where the 
Force curve data is (.ibw files) filled with converted tab delimited files. This way is 
much easier, only flaw of the program is that it doesn’t put name of individual 
curve at top, like you can in single export protocol. 
-have Single Note checked  - this gives only one file with parameter info 
 

▪ Exporting Waves in Igor-  
You can export any wave in Igor.  90% of the battle is finding the wave. 
For any wave displayed on a graph: 
1) Double click on the wave.  You get a modify trace dialog. 
2) *Hold Down* the left mouse button on the name of the wave that looks 
like the correct wave.  The box below then shows the data folder that is 
holding that wave. 
3) Go to the Data → Data Browser menu. 
Locate the data folder that was shown by the dialog. 
Alt + left click to the left of that data folder.  There should now be a 
red arrow pointing at that folder and letting you know that you are 
sitting in that folder. 
4) Go to the Data→ Save Waves→ Save Delimited Text menu. 
Select the wave from the list of waves in that data folder. 
5) Click ‘Do it’.  Then select where you want to save that .dat file. 

 
▪ Deactivating Closed Loop Scanner: 
Go to ‘Setup’ in Main tab of master panel. Towards the bottom, click on the ‘Show?’  check box 
next to ‘Scan Mode’ pull-down - it contains the option to turn of the closed loop feature. 
 
▪ Making multiple copies of MFP software: When updating MFP software, but you want to keep 
your old version too, make a copy of Igor. See AR web site FAQs. Copy the Igor pro folder in 
Wavemetrics; rename it so you don’t get confused. Load the new software into this new folder. 
When you want to use it, go into this folder, click on the Igor Pro icon to load Igor; then go to File, 
new MFP template. This will load it properly. I have found that Igor can get mighty confused if you 
don’t do it this way. Contact Support@ for further insight…. 
 
▪ Overlaying two image channels: Requires knowledge of how to use ARgyle commands (see 
Section X). What is displayed is one channel as a z scale, while the other is displayed as a color 
scale. See Figure 42 below. 
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Process your two channels to your liking (i.e flatten, mask, pick colors). Create an ARgyle image 
for each image channel. The example used below is a height and phase image of a bacterium.  
▪ One of the channels needs to be grayscale (height), while the other is some color (phase). Use 
aspect 1 checkbox to adjust z scale in this one 

In the command line, type: argl_bindmesh(“filename/suffixHtTm0”,”filename/suffixPhTm0”) 
 
Example: argl_bindmesh("PAbacteria0022HtTm0","PAbacteria0022PhTm0") 
▪ The resulting ARgyle overlay will occur in one of the ARgyle windows. Specular light was added 
(shiny under Argyle light tab). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Phase image Height image 

Figure 42: Height/ Phase Overlay 
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XIII. TROUBLE SHOOTING: 
 

▪ False Engagement (in fluid)- decrease set point; in AC mode: decrease the set point, increase 
drive amplitude until piezo extends fully (150 V). 

 
▪ Quickly finding tip in CCD camera with top view optics when you feel you have ‘lost it’ 
(mirror way out of whack). Realigning the tip within the 10x top view optics can be quite an 
overwhelming trial and error undertaking if some user before you has completely ‘lost’ the tip by 
cranking the mirror alignment knobs all the way, and messing up the focus. But it doesn’t have to 
be that way! 
With suitable amount of light, the mirror can easily be realigned by looking into the mirror along 
the same vector as the top view optics path (whether from below (SA) or above (bio)). Turn mirror 
alignment knobs until you see tip chip and trapezoidal window; align so it’s in center. Put MFP-3D 
back on it’s scanner platform; play with focus until you find some feature that should be in same 
plane as tip chip;  move mirror alignment knobs slightly until you locate it. 
 
▪ Sum & Deflection Meter Freeze: This can occur if the cable connection isn’t good. With time, 
and all that repeated cable twisting from putting the head on its back while attending to the 
sample, the plug can wiggle its way out enough to cause the meter to freeze. TO FIX IT, power 
the controller off for 10 to 20 seconds, then turn back on. While you’re waiting, wiggle the plug 
back in a bit more.  
I have noticed any time one of the levels in the S&D meter aren’t responding properly, it’s a good 
idea to do some variation of the above procedure. 

 
▪ Rescan Bus: Sometimes if you have a freeze, or the system is hanging because Igor has 
been confused, click the ‘Rescan’ button (lower left). This pings all the hardware systems to 
make sure they are all communicating properly with each other (as far as I know). 
 
▪ Reducing noise in your system: I have discovered that keeping anything with a cooling fan 
off the desk that your controller is on. These items can translate their mechanical noise 
through the monster cable if all on the same desk. Our lab have a system from 2004 when AR 
was using a more rigid monster cable, which can transfer mechanical noise along it. In efforts 
to reduce this noise, I have sandwiched it between to 50 lb. bags of sand. 
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▪ NOISE MEASUREMENTS: This scope has the ability to test how much noise the system is 
experience, both internal and external. AR has a series of noise tests regarding the x, y & z inputs 
at different input voltages, and the 5 MHz A/D converter, known as the ‘Fast’ input. 

Go to programming → load test procedures. This creates a new pull down menu item called 
‘testing’ → test panel. The window below comes up. AR has specific testing parameters values 
that meet their specs before releasing their product.  

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

determine the InvOLS of the cantilever on clean mica or graphite (something atomically flat). AR 
spec tests use a 100 µm Si3N4 triangular cantilever. The value will automatically be updated in the 
sensitivity value. These noise numbers are sensitive to InvOLS, which in turn is sensitive to the 
‘Sum’ and individual cantilevers. Hence, don’t be sloppy with your InvOLS calibration when 
performing noise tests. 

 
The Fast input is measured two ways: engaged and disengaged (free air). Check the box below 
the fast column. The free air will give you a sense of how noisy the system is. The engaged 
measurement is going to give a real sense of how noisy the MFP’s environment is (i.e, Seismic, 
acoustical, mechanical, electrical, etc.) 

 
Free air: this checks the noise of the system, without the noise at the tip- sample interface 

Disengage the tip from the surface.  
Enter 70 V in ‘offset/lever’.  
Hit the ‘Start’ button; A noise plot comes up which shows the sampled noise (figure below). The 

fast input free air value should be less than 30 pm to meet AR’s specs. 
 
 

Engaged: this measurement monitors the noise at the tip-sample interface. 
Engage tip in contact mode.  
Adjust Integral gain to 0.01 (deactivates feedback loop). This step is important! 

Figure 43: Noise tab of the 3D Test Panel 

InvOLS
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Click ‘Start’; This will be an inherently noisier system because the tip is in contact with the 
substrate. The ‘Fast input’ (the 5 MHz ADC) engage value should be less than 60 pm to meet 
AR’s specs. Figure 44A shows a typical noise spectrum of a system that meets AR spec. 

 
- Figure 44B is an example of one of an MFP-3D’s Fast input ‘Engaged’ noise that is very noisy. 
You can see there is some period noise in the time plot (red). That works out to be around 32 Hz 
noise, which can be seen as a broad peak in the frequency plot (black lines in red box)- this 
suggests some mechanical external noise. In our case, I suspect it’s caused by some air handling 
equipment outside the old lab’s window. The spikes and peaks in the frequency plot show various 
types of external noise.  

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

When the tip is engaged, you can get an idea of how susceptible the system is to external 
noise using the headphones. If you can hear footsteps, door shutting, etc., you have an 
external noise issue. You can also hear the hum from the power source of the controller if 
the monster cable is not properly dampened between the controller and stage. 
 

X,Y,Z inputs: With the tip disengaged, you can monitor the noise of these inputs at –10, 70 & 150 
V (low end, middle and high end). Only one can be tested at a time. Values below 600 pm meet 
AR’s specs for the X & Y, while values below 300 pm meet specs for the Z input. 

 
I have compiled the following table of AR acceptable specs- 

 
Use 100 µm triangular Si3N4 tip (InvOLS ~ 30 nm/V); use  
mica or graphite surface for ‘engaged’ test 

 Fast X Y Z 

Engaged < 60 pm NA NA NA 

Free Air < 30 pm < 600 pm < 600 pm < 300 pm 

 

Figure 44: A) Typical fast engaged noise test meets spec; B) Fast Engaged spectrum showing mechanical noise in 
lower frequencies (and all over) 

60 Hz
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Figure 45: Calibration tab of 3D Test Panel 

 
▪ Scanner calibration: You can check the 
health of your scanner by clicking the 
Calibration tab of the 3D test panel (Figure 45 
Choose the scanner from the pull-down menu, 
make sure it is in the ‘Drive’ Action, and X  (Y 
or Z) start –10 V and range 160 V. Click 
‘Start’ button. A graph similar to Figure 46 
comes up. You should have a nominal range 
of ~ 14 V, and a hysteresis value of 4 % or 
less (not sure on AR’s specs on the 
percentage). 

 
  
 
▪ A properly functioning scanner will have a calibration plot that looks similar LVDT plot below 
(typical voltages are of ~14 V and hysteresis < 4%)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
▪ When done testing, go to programming → remove test procedures. 

 
 
 
 
 

Figure 46: typical LVDT (X or Y) scanner hystersis plot. 
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XIV. COMMON COMMANDS: Here’s a list of some common commands that may be useful 
 
Bindmesh (overlay images) 
ArGL_BindMesh("HeightImage0HtT","PhaseImage0PhT") 

 
Render images in 3D (anaglyphs) using Argyle  
Argl_WriteValue(“”,”anaglyph”,1) //turns ON Anaglyph in Argyl window  
Argl_WriteValue(“”,”anaglyph”,0) //turns OFF Anaglyph in Argyl window  

 
Monitor system parameters  
print td_ReadValue("Temperature%Default@Head") //reads temp at head  
print td_ReadValue("Temperature%Default@scanner") //reads temp at scanner  

 
Turn ON/OFF the blinking LED at the XYlvdt board and head  
print td_WriteValue("LedBlinking%Default@XYLVDT", 1) //turns ON LED at XYLVDT board  
print td_WriteValue("LedBlinking%Default@XYLVDT", 0) //turns OFF LED at XYLVDT board  

 
print td_WriteValue("LedBlinking%Default@head", 1) //turns ON LED at head  
print td_WriteValue("LedBlinking%Default@head", 0) //turns OFF LED at head  

 
Set/read output voltage to XYZ piezo  
print td_writevalue("Z%Output@Controller", 70) //sets output to Z piezo  
print td_readvalue("Z%input@Controller") //reads z piezo voltage  

 
print td_wv("y%output", 70) //sets output to Y piezo  
print td_wv("x%output", 70) //sets output to X piezo  

 
Send voltage pulse output (OutA) using DAC (eg…2V, -2)  
print td_WriteValue("A%Output", 2);print td_WriteValue("A%Output", 0)  
print td_WriteValue("A%Output", -2);print td_WriteValue("A%Output", 0)  

 
Print out what 50 pN is in Volts for your given Spring constant and Invols. Useful for 
setting a trigger during force curves  
Variable MyForce = 50e-12 //I want 50 pN.  
Print MyForce/GV("SpringConstant")/GV("Invols")  
 

 
Display captured video image  
//First set the data folder to :root or create one like root:Video or root:Capture  
//Then click capture button  
NewImage capture  

 
Better way of displaying captured video image  
Display; AppendImage capture; ModifyGraph height={Plan, 1, left, bottom}  
 
Rename captured video image so it doesn't get overwritten (example) 
Rename capture pollenA  

 
Generate a piecewise continuous wave  
Make/N=65535 wave0, wave1, wave2, wave3  
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wave0 = (p<32768)?(0):(1)  
wave1 = (p<16384)?(0):((p<32768)?(5):((p<49152)?(-5):(0)))  
piecewise linear  
wave2 = (p<32768)?(-5+p*10/32768):(15-p*10/32768)  

 
Output a wave to Out0 and collect from In0 in sync  
//write crosspoint to connect Out0 to OutA and In0 to InA  
print td_Stop() //usually not necessary but safest  
print td_xSetOutWave(1, "2,2", "A%Output@Controller", wave2, 2)  
print td_xSetInWave(1, "2,2", "A%Input@Controller", wave3, "print 42", 2)  
print td_WriteString("2%Event@Controller","Once")  
//wait for it to print 42  
Display wave3  
Note: be sure to read the help for td_xSetInWave and td_xSetOutWave on banks, decimation, 
and interpolation. In particular, you want the decimation and interpolation to be the same if you 
want to correlate input with output.  

 
Integrate noise spectra to find biggest contributor  
//From noise panel, click Save  
//In Test Results:Noise, rename folder to a unique name (X01 not X, FastOffSurf not Fast)  
//Make that the current data folder  
Duplicate /O PSD Int  
Int *= Int //omit this line if you are using *true* PSD from Mario's new panel  
//old Noise panel gives amplitude spectral density as "PSD" and must be squared  
Integrate Int  
Display PSD; AppendToGraph /R Int  
ModifyGraph log(bottom)=1  
ModifyGraph RGB(Int)=(0,0,65535)  
ShowInfo  
//Now look for the biggest step(s) in the blue integrated curve.  
Retrieved from "http://wiki.AsylumResearch.com/Common_Commands" 
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XV. RF’s QUICK REFERENCE: 
 
Tip loading: gently slide tip under tongue, such that tip is in middle of clear trapezoidal window; tighten 
screw finger tight with screwdriver. (see page 3) 

 
Set point determination in Contact mode: after SLD (laser) alignment, adjust PD to slightly negative 
value; choose set point higher than this for gently engagement. In contact mode, higher set point (voltage) 
values translate to higher applied force. (see pages 7-8) 

 
Spring constant, k, determination: 1) Force curve on a clean hard surface; determine InvOLS (cursors 
on slope of contact region → Set Sens → Deflection). 2) Disengage tip; perform Thermal tune; Fit first 
resonance peak to get k. (see page 11-15)  
Set point determination in AC mode: Pick a set point that is ~ 10 to 20% of the free air amplitude (value 
in Sum & Deflection meter). In AC mode, lower set point (voltage) values translate into higher forces. (see 
page 17) 

 
Auto Tune Drive frequency in AC mode: Align laser on tip; zero PD; Do thermal to get approximate 
resonant peak; enter frequency range that flanks this value; Click ‘Auto Tune’; Engage tip/ image. (see 
page 16)  
Picking Drive Frequency when imaging in fluid: Align laser; Do thermal; approximate resonant 
frequency of cantilever & enter in drive frequency value of Tune tab; seslect ‘Append Thermal’  
checkbox; perform ‘One Tune’ with a ~15 kHz window; use cross cursor to select point on black frequency 
plot that is near the resonant peak of the thermal (red) scatter plot; select ‘set drive frequency as ‘. Drive 
frequency updated in Tune & Main tabs. (see pages 19-20) 
Alternatively, perform thermal tune; manually pick frequency by placing Igor cursor on left side of peak; 
type this value into drive frequency; Engage tip; after engagement, use ‘Hamster’ wheel (front of controller) 
to fine tune drive frequency by monitoring the phase & amplitude images, and line traces. (see page 20 -
21) 

 
Gentle Engagement (AC mode): Pick a set point that is ~ 5% of the free air amplitude; Click ‘Simple 
Engage’ to activate piezo; Thumbwheel down until tip engages (which is a false engagement). Adjust set 
point with Hamster to ‘hard’ engage tip; you may have to use thumbwheel to adjust piezo further, but it’s 
already under feedback, so you’re pretty safe. (see page 17) 

 
Monitoring Phase during AC mode imaging: While imaging in air, you can monitor the Phase levels 
(Sum & Deflection meter) to determine whether the tip is in the attractive (intermittent contact) or repulsive 
(non-contact) regime with respect to the sample. ATTRACTIVE > 90° > REPULSIVE (see page 18) 

 
Saving images: File → Save Graphics…; Filename, image size and file type of your choice, click ‘path’ → 
choose where you want to dump it; click ‘Do it’ (see page 38)  
Saving images from ccd camera (top down view model): Create path to dump file (Misc → New Path… 
choose path; ‘Do it’. Select Capture on ccd image; Data → data browser; right click on capture, select new 
image; Save image. (see page 38) 

 
Creating a ‘Path’ in Igor to save images: Misc → New Path; name your path; click ‘Path’; click ‘Do it’. 
(see page 38) 

 
Exporting Line sections: In the line section graph panel that comes up, click on ‘Edit’, which brings up a 
new table with one column of data in it. ‘Kill’ it. Then go to Windows → New Table. Select the four waves in  
‘Columns to edit’ that end with the following suffices: 

(Filename-suffix)lHtT, QHtT, XHtT & _HtT; click ‘Do It’  (see page 32) 
 

Real time Section analysis: During imaging, go to MFP IP→ Analyze Panel; Select Real Time  
checkbox; follow directions on page 31 
 
Shutdown: Withdraw tip; turn off laser; if working in fluid, clean tip holder, dry. (see page 10) 

 


